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Chapter 1

ScreenFool

1.1 ScreenFool 3.0 AmigaGuide documentation

ScreenFool 3.0 User Documentation
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Common~display~identifiers
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Revision~History

1.2 What is ScreenFool?

What Is ScreenFool?

ScreenFool is a utility for Amigas with Release 2 or later of the operating
system. It allows you to work with so-called "Public" screens and thereby
enhance your productivity, by allowing Workbench screen (and other)
applications to use a different screen than the regular Workbench.

1.3 ScreenFool’s features

Features:

ScreenFool has three main interfaces: the Intuition (GUI) interface, the
Commodities (hot-key) interface, and the ARexx macro interface.

Some features of the Intuition interface include:

· Open a public screen in any available Intuition-supported display mode. *

· Close any open public screen.

· Make all windows that open on Workbench open on another screen (
SHANGHAI
).

· Set a
default~public~screen
for applications.

· Pop a screen to front when a visitor window appears on it (
AUTOPOP
).

· Change public screen palettes.

·
Localization
under Release 2.1 and above.

·
Font-sensitive
GUI.

The Commodities interface supports:

· Commodities Exchange control of the program window.

· Hiding and showing the control window.
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· Hotkey access.

The ARexx interface supports:

· All Intuition and Commodities interface functions, plus:

· Obtaining information on available screens and display modes

· Numeric palette setting

· Options not included in the GUI.

Workbench.library support:

· Pop up the window at any time from Workbench’s Tools menu.

* Full capability requires a keyfile that will be sent upon
registration

1.4 System Requirements

System Requirements:

* AmigaDOS Release 2 or later (Intuition V37)

* 512K RAM (Much more recommended if you’re opening many screens)

* Any processor

ScreenFool is compatible with advanced processors and Release 3. It has been
tested on a V37 (final) A2000 system with 3 MB RAM, 80 MB hard disk, and 68000
processor (7.14 MHz); and on a V39 A4000 system with 8 MB RAM, 120 MB hard
disk, and 68040 processor (25 MHz).

1.5 Copyright and Registration Issues

Copyright:

ScreenFool is Copyright © 1992-94 Chris Lawrence. It is copyrighted
shareware: you may make as many duplicate copies as you wish, provided the
following restrictions are followed:

1. The program itself must remain unaltered.

2. This documentation file, and any others included, must remain unaltered.

3. The file reqtools.library is unaltered
(ReqTools is Copyright © 1991-94 Nico Francois)

4. The demonstration scripts and README file remain unaltered.

This archive may be included on the Fred Fish CD series (Frozen Fish, Fresh
Fish, etc.) and the Aminet CD-ROM. If you are interested in some other form of
distribution, contact the author at the address below.
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Registration Details:

If you are satisfied with this program, you may send a registration fee of $5
($10 for the program on disk via snail mail) to:

Chris Lawrence
Box 574060
Georgetown University
Washington, DC 20057-4060
United States of America

Registering ScreenFool will entitle you to:

· Immediately receive a keyfile

· Free upgrades (*) of registered version for eternity after registration.
This includes both maintenance upgrades and full upgrades.

· Full technical support

· Future upgrades - period. No money, no enhancements

* Upgrades by mail will be assessed a $2 handling fee for disk cost,
shipping and handling. Upgrades downloaded from Aminet or obtained
on BBSes are free.

Please include your mailing address with payment (US currency, cashier’s
check, postal order) for a prompt upgrade. Personal checks: allow 2-4 weeks
for check to clear. For fastest possible receipt of the keyfile, include an
Internet E-Mail address (will be sent as uuencoded .lha file).

Other correspondence can be sent to the above address, or via the Internet to
clawrenc@cap.gwu.edu.

If you have previously registered ScreenFool and have not received a keyfile
for this and future releases, please drop me a line.

Keyfiles:

Basically, they are governed by common sense. For those budding lawyers out
there, it’s spelled out below.

AGREEMENT FOR THE USE OF KEYFILES FOR SCREENFOOL

If you have registered the program, you are entitled to a keyfile that enables
the New Screen requester. Upon receipt of the keyfile, you may use the keyfile
on one system at any given time. The file may be duplicated onto any computers
that you may own, lease, or rent, but must not be allowed to be distributed to
computers owned, leased, or rented by another individual. Additional keyfiles
for additional systems under your control may be issued at the discretion of
the author for $2 each. (These keyfiles will bear different registration
numbers for tracking purposes.) Additional keyfiles are licenced from the main
keyfile, and all of your keyfiles are considered a indivisible unit.

In essence: you may use a specific ScreenFool keyfile on one Amiga at a time.
To use the New Screen requester on two Amigas at one time, you must have two
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keyfiles. Additional keyfiles are $2 each. All additional keyfiles must be
retained by the owner of the main keyfile.

You may transfer all of your keyfiles to another individual, provided that you
destroy all copies of all of your keyfiles, the other individual has read and
understood this license, and you inform the author within thirty (30) days of
the transfer. You must inform the author of the name, address, and email
address (if applicable) of the transferee. The transferee will receive all of
the rights that a registered ScreenFool user is entitled to, and you will be
required to either re-register or be transferred the rights to another
person’s keyfiles in order to be considered a registered user again. There is
no fee for a keyfile transfer. You may charge the transferee for the rights to
your keyfiles if you wish. You must transfer all of your keyfiles, or not
transfer any of them. Renting or leasing of keyfiles is not permitted.

In essence: you may sell ALL of your keyfiles to another individual. The other
individual will receive all of the rights to ScreenFool that you had
previously received, and you will revert to having the rights of an
unregistered user. There is no limit to the number of transfers that can be
made of a specific set of keyfiles.

Keyfiles may not be placed in (a) download directories of Bulletin Board
Systems, (b) world-read directories of an AFS-based system, (c) world-read
directories of an FTP site, (d) world-read directories of an FSP site, or (e)
any place where an anonymous or unentitled (person who has not registered
ScreenFool or been transferred someone else’s registration) user might be able
to receive a copy of the file (excepting floppy diskettes used for personal
storage).

It is illegal for an unentitled user to use a keyfile. Violations will be
prosecuted to the fullest extent of the law.

By receiving a keyfile and using it, you imply consent to this agreement.

Exceptions to this agreement must be made by the author (me) in writing.

Please Note:

Many terms used in this document are trademarks or registered trademarks. This
is generally indicated by the use of capital letters, i.e. AmigaGuide.

1.6 The Font-Sensitive GUI

The Font-Sensitive GUI:

ScreenFool Release 2.4U added the additional feature of a font-sensitive GUI
to the ScreenFool interface. Basically, ScreenFool tries to adapt to the
screen font of screens that it opens on.

There are certain limitations to this feature:

1) If the screen font is greater than 18 point, the GUI reverts to topaz.

2) If ScreenFool thinks that the screen is too small to display the full
window, ScreenFool will revert to topaz 8, or the BACKUPFONT set in the
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Tool~Types
. If topaz or BACKUPFONT is still too large, ScreenFool

will attempt to use SystemThin.font 8 point, which is a narrow font
supplied with ProWrite, or the SMALLFONT set in the

Tool~Types
.

** SystemThin.font IS NOT REQUIRED FOR SCREENFOOL TO WORK.

3) If your font has a tf_XSize somewhere in the vicinity of machine
infinity, as is the case with many poorly designed fonts, ScreenFool
will go through the steps as outlined in limitation 2, above.

4) The window may look odd at point sizes outside the 6-12 range. This is
due to the fact that ScreenFool has not been extensively tested with
very large and very small fonts.

5) Under Release 3 and later, the checkmarks are scaled if the font is
greater than 11 points tall.

Please let me know about any enhancements you would like to see in the GUI
font adaptivity.

1.7 ScreenFool and Localization

Localization:

ScreenFool 3.0 and above include language localization features. As demand for
different languages becomes apparent, I will release new language catalogs for
ScreenFool.

The current release includes the following languages:

· English (internal)
· Français

Please note that Release 2.1 or later of the Amiga operating system is
required for localization to work.

If you would like to localize ScreenFool to your language, follow the
following steps:

1. Edit the ScreenFool_translation.ct file, translating the provided English
strings to your language.

2. Send the completed file to me, either by electronic or snail mail.

I will create the catalog file and mail it to you. In addition, your
translation may be included with the next public release of ScreenFool. If
this is the case, you will receive either a free registration or a refund of
your registration fee.

Inclusion of translations is at the sole discretion of the author (me).
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1.8 Installation

Installation:

ScreenFool 3.0 and above include an Installer script. To install ScreenFool,
you’ll need a copy of Installer somewhere in your search path (check your
operating system Install disk if you don’t already have Installer on your hard
drive).

Double-click on the Installer icon to begin the installation process. If you
choose a "User Level" of Novice, the program will automatically be installed
to your SYS:WBStartup directory; otherwise, you will be able to choose from
three installation options: SYS:WBStartup, SYS:Tools/Commodities, or
Custom...

Installing to one of the Boot volume directories will install the libraries,
this help file, and catalog files to the default system directories. This
method is recommended if you will use ScreenFool often.

You can also install to a Custom directory. This will create a drawer called
ScreenFool which contains all of the files ScreenFool needs to operate;
however, reqtools.library will still be installed to your Libs: path (if
necessary).

1.9 Some basic terminology

Terms You Need To Know:

PUBLIC SCREEN: A screen that other programs are allowed to open windows on.
Intuition V36 (Release 2.0) and later support this feature. Many programs
can open on a public screen.

DEFAULT SCREEN: The screen that applications that do not open their own
screen will open onto. For pre-V36 applications, this was Workbench.
Newer applications will go to this screen.

VISITOR WINDOW: A window on a public screen opened by an application that
didn’t open the screen. The ScreenFool main window is a visitor window,
as is the IconEdit window.

DISPLAY ID: A number that represents a specific display mode. For example,
a low resolution, non-interlaced screen has a display ID of 0. For more
details, see the

Display~ID~reference
.

MODE PROMOTION: A feature of Release 3 (V39) of graphics.library, which
allows some screen modes to be essentially replaced by others. For
example, DBLNTSC:High Res No Flicker replaces NTSC:High Res Laced.
ScreenFool fully supports Mode Promotion.

FLAG: A variable that can only have a value of on or off.

SHANGHAI: A system flag that determines the behavior of the default public
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screen. If this flag is set, pre-V36 applications will open on the
default public screen, even if they ask for Workbench.

AUTOPOP: A system flag that makes a public screen to pop to the front when a
visitor window opens on it.

INTERLEAVED BITMAP: A screen type, only available in Release 3 and later,
which improves the display on many-bitplane screens by reducing the
"color flashing" during scrolling. ScreenFool opens its screens on
V39 systems as interleaved, unless you override this behavior.
Pre-V39 systems use a "standard bitmap," as does V39 if you use the

NEW~NOTINTERLEAVED
macro command.

1.10 Running and Using ScreenFool

Running And Using:

To run ScreenFool from the Workbench, double-click the Commodity icon labelled
ScreenFool (if you are using a 68020 or higher computer, use the icon labelled
ScreenFool-AP).

To run ScreenFool from the Shell, type "ScreenFool" at the command prompt. If
you want to continue using the current shell window, type:

run <nil: >nil: ScreenFool

If you wish to set startup options from either Workbench or the Shell, see the
section on

Tool~Types
.

The ScreenFool~window will then be displayed. This window allows you to
manipulate the screens in the scrolling list.

The action gadgets on the right of the scrolling list (from top) will open a
new screen, close the selected screen, and change the selected screen to the
default screen.

The two checkboxes,
Shanghai
and

AutoPop
change the behavior of all Public

screens. Both default to OFF on the Amiga under Releases 2 and 3.

The two message lines at the bottom of the window display the name of the
default screen and messages from executed commands. The status line might say
’Couldn’t close screen’ if you tried to close a screen with windows still open
on it, for example.

Other features are concealed in the menus. All choices have keyboard
equivalents. Note that you may use either Right Amiga-key combinations or the
letter on its own. By menu, they are:
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Project Menu:

About...
(?) - Display program information.

Hide
(H) - Conceal program user interface.

Quit
(Q) - Exit the program.

Screen Menu:

New...
(N) - Open a new screen.

Close
(C) - Close selected screen.

Make~Default
(D) - Make the selected screen the default screen.

To~Front
(F) - Bring selected screen to front of stack.

To~Back
(B) - Move selected screen to back of stack.

Palette...
(P) - Change the palette for selected screen.

Write~Palette...
(W) - Write a screen’s palette to a script.

Information...
(I) - Show screen name, resolution, etc.

Tools Menu:

Jump~Window
(J) - Jump the ScreenFool window to the selected screen.

Update~Display
(U) - Refresh scrolling and display mode lists.

Help...
(L) - Get information on various topics.

Macro Menu:

Command...
(X) - Execute a single command line.
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Macro~»~Console...
(,) - Execute an ARexx macro with a window to

display the output.

Macro~»~No~Console...
(M) - Execute an ARexx macro without a window

to display any output (output redirected to NIL:).

For further information on menu choices, pull down the menu to the option you
want information for, and then press Help BEFORE releasing the right mouse
button.

Important note: Help is only available if the file ScreenFool.guide is in the
directory that ScreenFool is launched from, the LOCALE:Help/English directory,
or in a directory in the AmigaGuide search path.

1.11 Tool Types

Tool Types and Shell Options:

These options can be added to the Tool Types by using the "Icons »
Information..." option on the Workbench. From the Shell, they can be used by
following the ScreenFool command with the tool type and its option, in quotes,
as below:

ScreenFool "TYPE1=OPTION1" "TYPE2=OPTION2" ...

The available Tool Types are:

DONOTWAIT - Make sure this Tool Type is included if ScreenFool will be run
in WBStartup.

CX_POPUP - YES to have window pop up immediately when run; NO to hide window
until summoned by hotkey or Commodities Exchange. Default: YES.

CX_POPKEY - The key specification for the keypress that will pop up the
window. Default is "Control F1". The keypress combinations are listed on
page 5-29 of "Using the System Software" (2.0 users) and on page 10-25 of
the "Workbench 3.0" manual.

CX_PRIORITY - Sets relative priority of the ScreenFool program, from~127
to -128 (to other commodities). Defaults to 0.

STARTUP - ARexx macro to automatically run on startup. Defaults to
"SF-Startup". ScreenFool uses a ".sf" extension on its macros, so
SF-Startup.sf would be the proper name for the startup macro.

PORTNAME - Name for the ARexx port. Normally "ScreenFool.1".

PUBSCREEN - Name of the screen for ScreenFool to initially open on. Will
normally open on the default screen.

COMMAND - A single macro command to run when the program initially starts.
Normally there is no command.
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REXXDIR - Default macro directory. REXX: if omitted.

BACKUPFONT - Font to use when screen font is too large. The default is
topaz.font.

BACKUPSIZE - Point size for BACKUPFONT; defaults to 8.

SMALLFONT - Font to use when screen and backup fonts are too large. The
default is SystemThin.font.

SMALLSIZE - Point size for SMALLFONT; defaults to 8.

WEIRDMODES - Set WEIRDMODES=YES if you want to see Extra Halfbrite and HAM
modes in the New Screen requester. Defaults to NO.

FINDKEY - Set to NO if you want to disable the Keyfile search. Defaults
to YES.

1.12 About: Obtain program information (GUI)

Project » About...

This option gives the version of the program, its registration status, the
name of the ARexx port, and a summary of available Chip and Fast RAM.

Hotkey: Amiga-?

1.13 Hide: Hide the control window (GUI)

Project » Hide

Hide the main window. The window can be brought back up again by pressing the
Commodities hotkey for this program (default: Control F1), by choosing "Show"
in the Commodities Exchange program, or by using the Workbench Tools menu.

Hotkey: Amiga-H

1.14 Quit: Exit ScreenFool (GUI)

Project » Quit

Quit ScreenFool. This can also be accomplished by using the Commodities "Kill"
button, or by breaking the ScreenFool process (using Control-C or the Shell
BREAK command).

Hotkey: Amiga-Q
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1.15 New: Open a new screen (GUI)

Screen » New...
New Screen... (Action button)

Opens a new screen, duplicating the characteristics of the screen that the
main window is currently open on.

Under Release 3 or later, the screen will be
interleaved
.

If you register, you will be able to manipulate the options for the new screen
in a requester.

The Listview gadget contains the available display modes.

The Screen Name text gadget is used to enter a name for the public screen.
This name must be unique.

The Overscan cycle gadget allows you to choose from Text, Graphics (Standard),
Maximum and Video overscan settings.

The Bitplanes slider gadget allows you to choose the number of bitplanes the
screen should use (use the left and right cursor keys to change it from the
keyboard). Note that all depths may not be available with HAM and EHB
displays, so use care.

The Width and Height integer gadgets and check-boxes allow you to choose the
screen’s width and height. Note that you can’t change the width and height of
OSCAN_VIDEO screens.

The Like Workbench checkbox, under Release 3 and later, allows you to create a
screen that is a direct clone of the Workbench screen automatically.

The Interleaved Screen checkbox, under Release 3 and later, creates a screen
that has properties that reduce flickering during scrolling.

Note that help is not available directly from the Open New Screen...
requester. This will be rectified in a later release.

Hotkey: Amiga-N

1.16 Close: Close a public screen (GUI)

Screen » Close
Close Screen (Action button)

Close the currently selected public screen. The screen will not close if any
windows are currently open on it.

The screen need not have been opened by ScreenFool.

Hotkey: Amiga-C
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1.17 Make Default: Change the default public screen (GUI)

Screen » Make Default
Make Default (Action button)

Change the
default~public~screen
to the currently selected public screen.

Hotkey: Amiga-D

1.18 To Front: Bring a public screen to the front (GUI)

Screen » To Front

Bring the selected public screen to the front of the display. A shortcut is to
double-click on the screen’s name in the list.

Hotkey: Amiga-F

1.19 To Back: Push a public screen to the back (GUI)

Screen » To Back

Push the selected public screen to the back of the display. This is probably
of limited usefulness.

Hotkey: Amiga-B

1.20 Information: Get information on a public screen (GUI)

Screen » Information...

Get information on the currently selected public screen. Information includes
the screen’s title, public screen name, display identifier, resolution, depth,
and font.

Under Release 3, the information requester also indicates if the screen’s
bitmap is

interleaved
.

Hotkey: Amiga-I

1.21 Palette: Change a public screen’s palette (GUI)
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Screen » Palette...

Change the palette of the currently selected public screen, using the reqtools
palette requester.

Hotkey: Amiga-P

1.22 Write Palette: Save a screen’s palette (GUI)

Screen » Write Palette...

Save the palette of the selected screen as a macro. This macro can be used to
set the colors of the screen by executing it later.

Hotkey: Amiga-W

1.23 Jump Window: Jump the window to another public screen (GUI)

Tools » Jump Window

Makes the control window appear on the currently selected public screen. This
screen will pop to the front, and the window will be made active.

Hotkey: Amiga-J

1.24 Update Display: Update the control window (GUI)

Tools » Update Display

Update the control window display. This is sometimes necessary after closing a
public screen.

Under ScreenFool 2.4U and later, this forces the reloading of the display mode
list. This is useful after opening another monitor or changing locales.

In future, an automated update may be done for locale changes.

Hotkey: Amiga-U

1.25 Help: Get information on ScreenFool commands

Tools » Help...

This option allows the user to get direct help on the gadgets on the screen.
In the requester, enter the name of the gadget you want information on.

Hotkey: Amiga-L
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1.26 Macro » Script Menu (GUI)

Macro » Script Menu

Use
Macro~»~Script~»~Console...
for an output window, or use

Macro~»~Script~»~No~Console...
for a script without a window.

1.27 Script » No Console: Execute ARexx macro (GUI)

Macro » Script » No Console...

Execute an ARexx macro without console input and output.

Hotkey: Amiga-M

1.28 Script » Console: Execute ARexx macro (GUI)

Macro » Script » Console...

Execute an ARexx macro with console input and output.

Hotkey: Amiga-,

1.29 Command: Execute macro command (GUI)

Macro » Command...

Execute a macro command line.

Hotkey: Amiga-X

1.30 Shanghai: Toggle the SHANGHAI flag (GUI)

Shanghai (Check box)

Toggle the
SHANGHAI
public screen flag.

Hotkey: S
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1.31 AutoPop: Toggle the AUTOPOP flag (GUI)

AutoPop (Check box)

Toggle the
AUTOPOP
pulic screen flag.

Hotkey: A

1.32 The Macro Interface

The ScreenFool macro interface:

One of ScreenFool’s most powerful features is the ability to run completely
under the control of an ARexx program or macro. This allows a lot of
versatility in using the program.

A few commands can return information. To obtain this information, OPTIONS
RESULTS must have been specified in the program; otherwise, you will need to
use the VAR or STEM option of a command.

After each command, the ARexx variable SFSTATUS will contain the text
currently on the status line. If RC is 0, this will usually state that the
action was completed OK; otherwise, it will be an error message.

There are three main ways of using the macro interface:

1. Use the
Macro~»~Command
(Amiga-X) command, to execute one command line.

2. Use the
Macro~»~Script
commands, to execute an ARexx program.

3. Create a macro called SF-Startup.sf, which will be automatically
executed on startup.

The
Macro~»~Command
command allows simple macro commands, like:

NEW DISPLAYID=0

Which would open a new, low resolution screen. (Note that case does not
matter, EXCEPT in screen names)

More complicated actions require the writing of scripts. This requires a text
editor.

Here’s an example script:

/* Example.sf -- A really dumb example */



ScreenFool 17 / 41

OPTIONS RESULTS

’new displayid=0 screenname="ReallyDumb.1"’

’info "ReallyDumb.1"’ /* displays information requester */

’close "ReallyDumb.1"’ /* End of script */

An example script file, SFTest.sf, shows the basic format of ScreenFool ARexx
script files. In addition, an example startup script is included which sets
the SHANGHAI and AUTOPOP flags every time ScreenFool is started.

Note that only one command can be entered at a time using
Macro~»~Command
or

the COMMAND tooltype. If ARexx is not available, the
Macro~»~Command
facility

is still available, however.

ARexx~Command~Listing

1.33 ARexx and Macro Commands

ARexx and Macro Commands:

Macro Commands

GetAttr

Macro

Command

NOP
Screen Management Functions

New

Close

Default

Front

Back

Palette

GetPalette

WritePalette
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Info

Shanghai

AutoPop
User Interface Control

Hide

Show

Jump

Requesters

LockGUI

UnlockGUI

StatusLine

Update

About

Quit
Aliases -- Old command names or style-guide synonyms

Get
for GetAttr

RX
for Macro

CmdShell
for Command

Deactivate
for LockGUI

Activate
for UnlockGUI

Status
for StatusLine

1.34 Hide: Hide the main window

Format: HIDE
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Close the program window until reopened by either pressing the hotkey or
sending the

Show
command.

See Also:
Show

1.35 Show: Show the main window

Format: SHOW

Open the program window on the screen that it was last on; or the default
screen (if the last screen has been closed, or ScreenFool has not opened its
window yet).

See Also:
Hide

1.36 Quit: Exit ScreenFool

Format: QUIT

Quit ScreenFool. All further ARexx commands to ScreenFool will return with an
error message.

1.37 About: Display program information

Format: ABOUT

Display the version information for this copy of ScreenFool in a requester.
Ignored if the ScreenFool window is hidden.

The requester will not be displayed if
Requesters
are off.

See Also:
Requesters

1.38 Shanghai: Change behavior of the default public screen

Format: SHANGHAI [On | Off | Toggle]

Change the global public screen flag that controls the behavior of the default
public screen. When on, even programs that request Workbench will get the
default screen; when off, only programs that don’t care what screen they get
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will get the default.

Options:
On/S: Sets the flag
Off/S: Clears the flag
Toggle/S: Toggles the flag

See Also:
AutoPop
,
SHANGHAI~Definition

1.39 AutoPop: Change AutoPop flag

Format: AUTOPOP [On | Off | Toggle]

Change the global public screen flag that determines whether a screen should
pop to the front when a window opens onto it.

Options:
On/S: Sets the flag
Off/S: Clears the flag
Toggle/S: Toggles the flag

See Also:
Shanghai
,
AUTOPOP~Definition

1.40 Requesters: Control display of ScreenFool requesters

Format: REQUESTERS [On | Off | Toggle]

Change the internal flag in ScreenFool that determines whether requesters will
be displayed requesting user input. This flag defaults to ON.

Options:
On/S: Sets the flag
Off/S: Clears the flag
Toggle/S: Toggles the flag

1.41 New: Open a new public screen

Format: NEW [ScreenName] DISPLAYID=[ID] PLANES=[Bitplanes] [NoGUI]
SCANTYPE=[Text | Standard | Max | Video] FONT=[name].font SIZE=[points]
[SysDefText] WIDTH=[width] HEIGHT=[height]

Extra V39 switches:
[NotInterleaved] [LikeWorkbench]
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Open a new screen, using the chosen parameters. The default settings for these
parameters are those of the screen that ScreenFool is (or was last) open on,
except for Font and Size, which are taken from Preferences’ Screen Text;

Interleaved
, which defaults On under V39; and LikeWorkbench, which is always

off unless set by the user.

All screens are opened, by default, with a full set of pens (including the
extra V39 pens, under V39), and with the full Workbench palette. Under V39,
the screen will share its pens. The AutoScroll flag is also set for screens
that exceed the DisplayClip region.

Options: {All Optional}
ScreenName - name for screen

(ScreenFool will make a name up if omitted (ScreenFool.x))

DisplayID/K/N - a valid
DisplayID
in decimal.

Hires=32768; Hires-Interlaced=32772.

Planes/K/N - number of bitplanes (1-maximum for this mode)

NoGUI/S - ensures requester will not be displayed, even if the user
has a keyfile.

ScanType/K - Overscan setting. One of:
Text
Standard
Max
Video

Font/K - A valid font name (for screen titlebar).
Include the .font extension.

Size/K/N - A valid height for the font.

SysDefText/S - Use the monospaced font as set in Preferences for
the screen font.

Width/K/N, Height/K/N - width and height for the screen

NotInterleaved/S - use a standard bitmap (under Release 3)
See

INTERLEAVED~BITMAP
for details.

LikeWorkbench/S - duplicate Workbench attributes (under Release 3)
Setting this flag on V39 will only permit the Interleaved flag to
function. This flag is ignored under V38 and earlier.

See Also:
Close
,
Display~IDs
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1.42 Close: Close an existing public screen

Format: CLOSE {Screen}

Close the specified public screen. This screen need not have been opened by
ScreenFool.

Options:
Screen/A - name of screen to close ** REQUIRED

See Also:
New

1.43 Default: Change the default public screen

Format: DEFAULT {Screen}

Make the selected screen the
default~public~screen
.

Options:
Screen/A - Name of the screen ** REQUIRED

See Also:
Definition~of~Default~Public~Screen
,
Shanghai

1.44 Info: Obtain information on a public screen

Format: INFO {Screen} STEM=[Stem] VAR=[Var] [NoGUI]

Get information on the selected public screen, and (optionally) return this
information to the macro.

Options:
Screen/A - name of screen to get info on ** REQUIRED
Stem/K - stem name to get stem result in. Fields will be filled as

follows:
.SCREEN - Handle
.TITLE - Default title
.DISPLAY.TITLE - Current title
.DISPLAY.NAME - Name of current display mode
.DISPLAY.ID - Display mode ID in decimal
.DISPLAY.WIDTH - Display width in pixels
.DISPLAY.HEIGHT - Display height in pixels
.DISPLAY.DEPTH - Screen bitplanes
.DISPLAY.COLORS - Screen colors
.DISPLAY.LEAVED - Is this screen

interleaved
? (Yes or No)
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.FONT.NAME - Name of screen font

.FONT.YSIZE - Screen font height
Var/K - variable name to obtain information in. Fields will be filled in

the same order as the stem.
NoGUI/S - Do not display requester with information. If there is not a

Var or Stem, ScreenFool sets RESULT equal to what Var would have been.

See Also:
GetAttr

1.45 Front: Bring a screen to the front

Format: FRONT {Screen}

Bring the specified public screen to the front of the display.

Options:
Screen/A - name of screen to bring to the front ** REQUIRED

See Also:
Back

1.46 Back: Send a screen to the back

Format: BACK {Screen}

Push the specified public screen to the back of the display. This command is
probably of limited usefulness.

Options:
Screen/A - name of screen to push to the back ** REQUIRED

See Also:
Front

1.47 Jump: Jump the ScreenFool window to a different screen

Format: JUMP {Screen}

Jump the ScreenFool window to a different screen. If the window is hidden when
the command is issued, it will be popped up.

Options:
Screen/A - name of screen to jump to ** REQUIRED

1.48 Palette: Allow user to edit the palette of a screen
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Format: PALETTE {Screen} [n] [r] [g] [b] [FullRes]

Edit the palette of the selected screen. If all that is specified is the name
of a public screen, the ReqTools palette requester will appear on that
screen.

If a palette entry number (between 0 and the maximum pen on the screen) is
given, direct RGB entries can be made, in the order Red Green Blue.

The FullRes option determines how the RGB values will be interpreted. By
default, ScreenFool uses a 256-level resolution in each position. This is
sufficient for both ECS and AGA Amigas.

Note that in the default system, the values range from 0-255. If running under
ECS, the values are mapped to the 0-15 range internally.

If FullRes is used, each color may be specified to 32-bit resolution.

Options:
Screen/A - name of screen to edit palette of ** REQUIRED

Entry/N - The palette entry. From 0 to 2**(planes)-1

Red/N - The Red value
Green/N - The Green value
Blue/N - The Blue value

FullRes/S - If set, use 32-bit color resolution.

See Also:
GetPalette
,
WritePalette

1.49 GetPalette: Get palette entries for a screen

Format: GETPALETTE {Screen} {n} [FullRes]

Returns the nth palette entry in RESULT, in the format "r g b".

The FullRes option determines how the RGB values will be returned. By default,
ScreenFool uses a 256-level resolution in each position. This is sufficient
for both ECS and AGA Amigas.

If FullRes is used, each color will be returned in 32-bit resolution. This may
be useful for high resolution video cards, AAA, and the like.

Options:
Screen/A - name of screen get an entry from ** REQUIRED

Entry/N/A - The palette entry. From 0 to 2**(planes)-1 ** REQUIRED

FullRes/S - If set, use 32-bit color resolution.
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See Also:
Palette

1.50 WritePalette: Save a screen’s palette to a file

Format: WRITEPALETTE {Screen} [Filename]

Writes the entire palette of the chosen screen to a file. If the screen has a
3.0 extended palette, the entire palette will be written.

This file can later be executed by the
RX
command, to change the colors of the

existing screen. It can also be edited to open the screen as well.

This command writes 32-bit resolution palette data.

Options:
Screen/A - name of screen get an entry from ** REQUIRED

Filename - name of file to write script to
If not specified, requester will be used.

See Also:
Palette

1.51 Command: Execute a single command line

Format: COMMAND [Commandline]
Alternate Form: CMDSHELL [Commandline]

Execute a single macro command line. If no commandline is offered by the
program, a requester will be popped up.

The CMDSHELL form is available for style-guide pseudo-compatibility.

Options:
Commandline/F - a command to be executed

See Also:
Macro

1.52 Macro: Execute an ARexx script

Format: MACRO [CONSOLE] WINDOW=[Windowspec] [ASYNCH] [Command]
Alternate Form: RX [CONSOLE] WINDOW=[Windowspec] [ASYNCH] [Command]

Execute an ARexx macro program. If no command is given, a file requester will
appear allowing the user to select a file to execute, or type a command line
(with options).
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The RX form, and the ASYNCH switch, are available for style-guide
pseudo-compatibility.

Options:
CONSOLE/S - Specify if you need a CON: window for I/O.
WINDOW/K - Specify a special window specification for I/O.
ASYNCH/S - Non-functional. All macros are asynchronous.
COMMAND/F - command line to send to ARexx. Filenames should have an

extension if the filename does not end with ".sf"

See Also:
Command

1.53 GetAttr: Get Attributes

Format: GETATTR {RequestType} VAR=[Var] STEM=[Stem]
Alternate Form: GET {RequestType} VAR=[Var] STEM=[Stem]

Get information directly from ScreenFool that is unavailable through the
Intuition interface.

Options:
RequestType/A - determines type of information to get -- see below.
Var/K - sets variable to get information into
Stem/K - sets stem to get information into.

Not applicable for DefScreen or SFScreen.

If neither VAR or STEM are specified, the information will be returned
(if possible) in RESULT.

These are the currently supported request types, along with the data that will
be returned when specified.

Screens
Var or Result - List of open screens, quote & space delimited
Stem - Will be set to the following:

stem.COUNT - Number of open screens
stem.0 to stem.(count-1) - Screen handles

Displays
Var or Result - List of display modes and their ID numbers
Stem - Set to the following:

stem.COUNT - Number of display modes available
stem.0 to .(count-1) - Groups:

stem.n.NAME - Display name
stem.n.ID - Display ID number
stem.n.PROP - Display property flags (see graphics/displayinfo.h)
stem.n.MAXDEPTH - Maximum number of bitplanes
stem.n.GFXWIDTH - Graphics overscan width
stem.n.GFXHEIGHT - Graphics overscan height
stem.n.TXTWIDTH - Text overscan width
stem.n.TXTHEIGHT - Text overscan height

Modes
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Var or Result - A string of the following format
"Shanghai AutoPop Requesters", where each flag is replaced by

On or Off, depending on the current state of the flag.
Stem

stem.SHANGHAI On/Off
stem.AUTOPOP On/Off
stem.REQUESTERS On/Off

DefScreen
Var or Result - Default public screen
Stem - No result

SFScreen
Var or Result - ScreenFool’s public screen
Stem - No result

Application
Var or Result - ScreenFool’s version information string
Stem - The following stem will be filled:

stem.VERSION - Normal version string
stem.COPYRIGHT - Copyright information
stem.SCREEN - Screen that the window is/was open on
stem.DEFSCREEN - The default public screen’s name
stem.PORTNAME - ARexx port name
stem.IVERSION - Internal version number. Includes compilation date

and time. Use this information in bug reports, please!
stem.SCREENS - Number of open public screens
stem.DISPLAYMODES - Number of available display modes. This will not

include dual-playfield modes, and may not include EHB and HAM modes,
depending on the

WEIRDMODES
tool type.

See Also:
Info

1.54 Help: Obsolete command

Format: HELP

This command is obsolete. The online help facility has been moved to an
AmigaGuide document. See

UserHelp
.

A call to this command will return "Command obsolete."

1.55 UserHelp: Open GUI AmigaGuide help

Format: USERHELP [topic]

Obtain help using the AmigaGuide help system. If no topic is specified, the
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"Running and Using" section of this .guide file will appear.

Options:
topic - The topic to be looked up

1.56 NOP: No operation

Format: NOP

No operation. Included for style-guide pseudo-compatibility.

1.57 Update: Update the ScreenFool window

Format: UPDATE

Refresh the ScreenFool window. This command is occasionally necessary from
macro programs.

Under ScreenFool 2.4U and later, this forces a reload of the display mode
listing. An automated UPDATE may be done in future versions if the locale is
changed.

1.58 StatusLine: Display a message on the status line

Format: STATUSLINE [message]
Alternate Form: STATUS [message]

Display a message on the ScreenFool status line.

Options:
Message/F - message to display

1.59 LockGUI: Inhibit user interface function

Format: LOCKGUI
Alternate Form: DEACTIVATE

Lock ScreenFool’s user interface from Intuition access. This is useful in some
macro programs, such as PSPub.sf, which change the default public screen.

The DEACTIVATE form is provided for style-guide compatibility.

See Also:
UnlockGUI
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1.60 UnlockGUI: Re-enable user interface function

Format: UNLOCKGUI
Alternate Form: ACTIVATE

Unlock ScreenFool’s user interface. If multiple outstanding locks, will not
take effect until all locks are unlocked.

The ACTIVATE form is provided for style-guide compatibility.

See Also:
LockGUI

1.61 In conclusion...

Some Features Not Mentioned Elsewhere:

Double-clicking on a screen name in the scrolling list will bring that screen
to the front. Note that double-clicking is NOT supported in the display mode
list.

You can use the up and down cursor keys to select screens from the scrolling
lists.

Using the "Tools » ScreenFool" menu option on the Workbench will pop the
ScreenFool window to the front.

For help on options without menu items (for example, Shanghai and AutoPop),
press L and then type the option name into the requester that appears and
press Return. [Look for gadget help in an upcoming release]

You can quit ScreenFool while public screens that it opened are still open. If
you want to close the screens, use ScreenFool to close them later (simply
re-run ScreenFool). The screens can also be closed by other applications;
however, this will result in a loss of approximately 400 bytes of memory per
screen.

The screen mode choices are, by default, limited to non-ExtraHalfBrite,
non-HAM modes. ScreenFool refuses to open a screen in one of these modes when
they are excluded, even from the command line. This behavior may be changed by
using the

WEIRDMODES
tool type.

In Scripts:

If you want a high resolution "laced" (640x400) screen, specify the generic
display ID 0x8004 (decimal 32772), not the NTSC or PAL specific display ID.
This provides maximum compatibility with Mode Promotion under Release 3 and
above. These can be found in the C header file <graphics/displayinfo.h> (under
Release 3, <graphics/modeid.h>) or by making a copy of the output from
ScreenFool’s

GetAttr~Displays
or from the ShowAvailModes example included in
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the screenfool.library developer distribution.

I hope that you enjoy ScreenFool!

Chris Lawrence
17 August 1994

1.62 Versions covered

VERSIONS COVERED IN THIS DOCUMENT:

ScreenFool 2.7 (5.9.94)
ScreenFool 2.7-AP020 (5.9.94)

ScreenFool is Copyright © 1992-94 Chris Lawrence
screenfool.guide and screenfool.library are Copyright © 1993-94 Chris

Lawrence

The user interface design is intellectual property of the National
Broadcasting Corporation, 30 Rockefeller Plaza, New York, NY 10011, and may
not be reproduced without their express written consent.

Damned is he who wears the yellow hat. -- I Corinthians 22:6

1.63 Appendix: Display ID reference

This is a brief guide to the most often-used available DisplayIDs ←↩
in

ScreenFool. A more complete list can be found using
GetAttr~Displays
(as

demonstrated in the script SFTest.sf). Note that display IDs returned by this
function are absolute (monitor-specific), not generic.

Use the generic IDs in scripts for compatibility with Mode Promotion and
international systems. Unrecognized display IDs are converted to generic HiRes
in attempt to recover from script errors.

Please note that several monitors are not included in this list, notably the
Euro36 and Euro72 monitors (which provide European systems with NTSC
resolutions at higher refresh rates) and the Super72 monitor.

Default.monitor (NTSC/PAL/DblNTSC/DblPAL)

Name Resolution Display ID Display ID
(hex) (decimal)

LowRes 320x200 (256)$^1$$^2$ 0x0 0

HiRes 640x200 (256)$^2$ 0x8000 32768

SuperHiRes 1280x200 (256) 0x8020 32800
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LowResLace 320x400 (512)$^2$ 0x4 4

HiResLace 640x400 (512)$^2$ 0x8004 32772

SuperHiResLace 1280x400 (512) 0x8024 32804

Multisync.monitor (VGA/Multisync) *

Productivity 640x480 $^3$ 0x39024 233508

ProductLaced 640x960 $^3$ 0x39025 233509

Doublescan (AGA) monitors *

LoRes-DblLace 320x800 (1024) 0x5 5

HiRes-DblLace 640x800 (1024) 0x8005 32773

$^1$ Parentheses indicate PAL (50 Hz) vertical resolution. These resolutions are
non-overscan and typical of Pre-2.0 screens.

$^2$ Promoted by Mode Promotion

$^3$ No overscan

* These resolutions require a VGA or Multisync monitor

1.64 Appendix: A Note About Version Numbers

There are two "revision tracks" for ScreenFool. They are Regular and Advanced
Processor. The version string of the program depends on what track of
ScreenFool you are using.

The regular version has version strings of the format:

ScreenFool x.x (d.m.y)

The advanced processor version has a version string like:

ScreenFool x.x-AP020 (d.m.y)

1.65 Appendix: Revision History

The following is a brief revision history of ScreenFool.

This Version: ScreenFool 3.0a (**INTERIM**)

CHANGES FROM SCREENFOOL 2.7 (5.9.94)
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* Localization! Maintenant, on peut utiliser ScreenFool en français!
(A .ct file is included, for your edification.)

* Uses Installer. Now, two installation choices: If you run ScreenFool out
of one directory, you can install the entire system there. Or, if you run
it in WBStartup or Commodities, install the files to system directories.

* Shortcut for
Screen~»~Palette...
changed to Amiga-P from Amiga-E.

(Forgot that P had been unused since I got my Amiga User Interface Style
Guide & changed AutoPop to A (from P) and About to ? (from A))

* Fixed bug that made ScreenFool crash if you did a GETATTR DISPLAYS and
there were more than about 40 modes available. Upper limit increased to
around 120.
Thanks to Nigel Davidson for reporting this.

CHANGES FROM SCREENFOOL 2.6 (17.8.94)

* Direct setting of RGB values now available in the
PALETTE
macro command.

* New
GETPALETTE
macro command to get specified palette entries.

* Includes ablity to
write~a~screen’s~palette
to a script file.

* Includes Advanced Processor version in standard distribution.

CHANGES FROM SCREENFOOL 2.5U (13.1.94)

* Registered and Unregistered releases combined into one program. Currently
registered users will receive a keyfile that enables the New Screen
requester.

CHANGES FROM SCREENFOOL 2.4U (11.9.93)

*
UPDATE
function now expanded in scope. May now force a mode list update.

* Window disable functions implemented using more speed-efficient methods.

* Main program and library recompiled using SAS/C 6.51 -- better optimizer,
smaller code size.

* Library memory fragmentation greatly reduced.
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* Replaced extended character $\times$ with x, for better compatibility with
non-Amiga fonts.

* Registered version requester now has better unusual screenmode
identification and supports RTG monitors better (you set planes rather
than colors).

* Fixed bug with screen information requester not properly identifying
display modes without names.

CHANGES FROM SCREENFOOL 2.3U (6.9.93)

* Help file improved; incorrect references removed.

* Registered version mode requester improved.

* Now has a
font-sensitive
GUI.

* Bug in library that would sometimes create an empty screen list
removed.

* New
tool~types
are available to control fonts.

CHANGES FROM SCREENFOOL 2.2U (29.8.93)

* Help now moved to AmigaGuide file, resulting in a code decrease of
approximately 10K. Online help is only available if the .guide file
is in the directory ScreenFool is started from, or in a directory
which is listed in ENV:AmigaGuide/Path.

NOTE: amigaguide.library need not be present for ScreenFool to run.
However, no help will be available if the library is not opened.

* All documentation now in AmigaGuide format.

CHANGES FROM SCREENFOOL 2.1U (13.7.93)

* Includes support for V39 NewLookMenus, and interleaved bitmap screens.

* Now includes better support for ReqTools V38.

* Checked with Enforcer.

CHANGES FROM SCREENFOOL 1.12U (11.7.93)

* Screen and display management functions moved to AmigaDOS shared library.
This transfer will benefit Amiga developers by making high-level
management functions available for all Amiga users (Release 2+).
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* Tooltype REXXDIR allows user to change default ARexx directory.

CHANGES FROM SCREENFOOL 1.11U/1.10U (Internal revisions)

* Memory loss fixes. All commands previously caused a loss of 520 bytes
from the system.

* Bug-fix in registered version’s New Screen interface -- the colors slider
now works correctly.

* Main window now WA_SimpleRefresh again
(Pick a WA_#?Refresh attribute, any WA_#?Refresh attribute)

* Newer Commodities 3.0-style interface

* Fixed bug that unlocked window if hidden and reopened using AppMenu

CHANGES FROM SCREENFOOL 1.9U (8.2.93)

* Recompiled with SAS/C Release 6.0 -- program slightly more efficient

* Tested on 68040-based system without problems

* Internal cleanups too numerous to mention here

CHANGES FROM SCREENFOOL 1.8U (16.1.93)

* Changed main window to WA_SmartRefresh

* Added available memory to About... requester

* Minor visual enhancements to About... requester

* Properly attached Activate and Deactivate ARexx commands to their actual
synonyms,

UnlockGUI
and

LockGUI
(Previously were attached to Hide and

Show)

* Added FONT and SIZE options to
NEW
command. See documentation for

further details.

CHANGES FROM SCREENFOOL 1.7U (5.1.93)

* Fixed bug that ate memory when an OpenPublicScreenA() failed.

* Better error reporting of why screens don’t open.

* Makes window use SystemThin.font (included with ProWrite) if opened on
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a low resolution screen. If not available, uses topaz.font.
NOTE: SystemThin.font IS NOT REQUIRED TO USE SCREENFOOL.

* Fixed bug with vertical spacing in gadgets in fonts other than 8 points
wide (that’s right, WIDE).

CHANGES FROM SCREENFOOL 1.6U (23.12.92)

* Fixed bug that would make status information act weird on a screen with
a font other than 8 points tall -- that was a weird one to fix.

* Internal support for opening screens with different fonts (implemented
via GUI for registered users) -- a command line option may be added later.

* (Not really a change): Tested with low memory (EatMem) -- passes with
flying colors (after your initial 40-50K load). Also tested using
Mungwall, MemWatch, Drip, and EatCycles.

CHANGES FROM SCREENFOOL 1.5U (19.12.92)

* ScreenFool now kills off less of your stack space -- 8K of stack is
sufficient.

* New ARexx command -
REQUESTERS~[ON~|~OFF~|~TOGGLE]
- choose to disable

the ScreenFool requesters for asynchronous operation without a user
present -- helpful if your ARexx macro might stop because of a missing
NOGUI option.

*
GETATTR~MODES
now includes the current Requesters mode.

1.66 Index

Index of database ScreenFool.guide

Documents

About: Display program information

About: Obtain program information (GUI)

Appendix: A Note About Version Numbers

Appendix: Display ID reference

Appendix: Revision History

ARexx and Macro Commands

AutoPop: Change AutoPop flag
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AutoPop: Toggle the AUTOPOP flag (GUI)

Back: Send a screen to the back

Close: Close a public screen (GUI)

Close: Close an existing public screen

Command: Execute a single command line

Command: Execute macro command (GUI)

Copyright and Registration Issues

Default: Change the default public screen

Front: Bring a screen to the front

GetAttr: Get Attributes

GetPalette: Get palette entries for a screen

Help: Get information on ScreenFool commands

Help: Obsolete command

Hide: Hide the control window (GUI)

Hide: Hide the main window

In conclusion...

Info: Obtain information on a public screen

Information: Get information on a public screen (GUI)

Installation

Jump Window: Jump the window to another public screen (GUI)

Jump: Jump the ScreenFool window to a different screen

LockGUI: Inhibit user interface function

Macro » Script Menu (GUI)

Macro: Execute an ARexx script

Make Default: Change the default public screen (GUI)

New: Open a new public screen

New: Open a new screen (GUI)

NOP: No operation
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Palette: Allow user to edit the palette of a screen

Palette: Change a public screen’s palette (GUI)

Quit: Exit ScreenFool

Quit: Exit ScreenFool (GUI)

Requesters: Control display of ScreenFool requesters

Running and Using ScreenFool

ScreenFool 3.0 AmigaGuide documentation

ScreenFool and Localization

ScreenFool’s features

Script » Console: Execute ARexx macro (GUI)

Script » No Console: Execute ARexx macro (GUI)

Shanghai: Change behavior of the default public screen

Shanghai: Toggle the SHANGHAI flag (GUI)

Show: Show the main window

Some basic terminology

StatusLine: Display a message on the status line

System Requirements

The Font-Sensitive GUI

The Macro Interface

To Back: Push a public screen to the back (GUI)

To Front: Bring a public screen to the front (GUI)

Tool Types

UnlockGUI: Re-enable user interface function

Update Display: Update the control window (GUI)

Update: Update the ScreenFool window

UserHelp: Open GUI AmigaGuide help

Versions covered

What is ScreenFool?

Write Palette: Save a screen’s palette (GUI)
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WritePalette: Save a screen’s palette to a file
Buttons

A~Note~About~Version~Numbers

A~summary~of~features

A~summary~of~terminology

About

About...

Activate

Additional~points

ARexx~Command~Listing

ARexx~Commands

AUTOPOP

AutoPop

AUTOPOP

AutoPop

AUTOPOP~Definition

Back

Close

Close

CmdShell

Command

Command...

Common~display~identifiers

Copyright~and~Registration

Deactivate

Default

default~public~screen

Definition~of~Default~Public~Screen
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Display~ID~reference

Display~IDs

DisplayID

Font-sensitive

Front

Get

GetAttr

GetAttr~Displays

GETATTR~MODES

GetPalette

Help...

Hide

Hide

Info

Information...

Installation

interleaved

INTERLEAVED~BITMAP

Jump

Jump~Window

Localization

LockGUI

Macro

Macro~»~Command

Macro~»~Console...

Macro~»~No~Console...

Macro~»~Script

Macro~»~Script~»~Console...

Macro~»~Script~»~No~Console...
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Make~Default

New

NEW~NOTINTERLEAVED

New...

NOP

Palette

Palette...
PSPub.sf

Quit

Quit

registration
requester

Requesters

REQUESTERS~[ON~|~OFF~|~TOGGLE]

Revision~History

Running~the~program

RX

Screen~»~Palette...
ScreenFool~window

SFTest.sf

SHANGHAI

Shanghai

SHANGHAI

Shanghai

SHANGHAI~Definition

Show

Status

StatusLine

System~Requirements

The~Macro~Interface
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To~Back

To~Front

Tool~Types

Tool~Types~and~Shell~Options

UnlockGUI

Update

UPDATE

Update~Display

UserHelp

WEIRDMODES

What~is~ScreenFool?

write~a~screen’s~palette

Write~Palette...

WritePalette
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